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DESCRIPTION OF VITALOGRAPH REPORTS 

Vitalograph Reports is a standalone PC application, which runs on 
Microsoft Windows 2000, XP and Vista (32 Bit) operating systems.  
The application runs in the Microsoft .NET 2.0 Framework which is 
also supplied and installed with this software if required.  The 
application interfaces with the Vitalograph ALPHA, Vitalograph In2itive, 
Vitalograph COMPACT, Vitalograph Micro, Vitalograph Model 4000, 
Vitalograph 2120 and the Vitalograph Gold Standard Plus devices, 
which in turn connect to the PC via an RS232 serial connector, USB 
adapter, USB cable or Bluetooth depending on the device. 
 
Once connected to the attached device and started, Vitalograph 
Reports listens for print messages/reports received from the device.  
When a complete report has been received from the device, the 
application sends the report to a connected printer or a PDF file or 
both; depending on what options the user has chosen.   
 
Vitalograph Reports provides the user with the option to generate the 
PDF file name automatically (based on the date and time the file was 
created), or to manually enter a file name each time the PDF report is 
ready for saving to the PC. 
 

FEATURES OF VITALOGRAPH REPORTS 

Vitalograph Reports Features include: 

1. An Install Wizard to step the user through the install 
process 

2. An Uninstall Wizard to step the user through the uninstall 
process 

3. Connect to a Vitalograph device 

4. Receive Spirometry report print data from the connected 
device 

5. Send the received report to a printer 

6. Create a PDF file from the received report and save to a 
folder on the PC 

7. Show the current status of the application  
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8. Configure the connected printer, device, port number, 
report location, naming of report file and whether to send to 
report a Printer, PDF file or both. 

 

RECOMMENDED REQUIREMENTS 

The following is a list of the minimum hardware and software 
requirements to run Vitalograph Reports.  Once you are sure you meet 
these requirements you can start following the instructions in this 
manual to install and then use Vitalograph Reports. 
Processor 1.2GHz Intel Pentium-class processor, or an AMD 

Opteron or AMD Athlon XP processor 
Operating 
Systems 

Windows 2000, Windows XP Professional, Windows 
XP Home Edition or Windows Vista (32 Bit) 

Memory 128 MB of RAM, 256 MB recommended 
Hard Disk 40MB for the Vitalograph Reports application 

280MB for the .NET framework 
Display 800 x 600 or higher-resolution display with 256 

colours 
Input Device Microsoft mouse or compatible pointing device 
Other • Installation of the .NET Framework 2.0 is split 

into two parts: the core and language packs. The 
core contains everything you need to run .NET 
Framework applications; all dialog boxes and 
error messages will be in English. If you want 
dialog boxes and error messages in another 
language, you must also install the 
corresponding language pack.  You will be 
prompted to do so during the installation 
process, if applicable. 

• CD-ROM drive 

• COM Port for Serial Devices or Serial to USB 
Converter 

• USB Port for the Vitalograph Model 4000, 
Vitalograph ALPHA, Vitalograph In2itive and 
Vitalograph COMPACT devices and Bluetooth 
adapter for the Vitalograph Model 4000 
Bluetooth Series. 

• Windows XP Service Pack 2 or Vista (32 Bit) is 
required for installation of Bluetooth drivers. 
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• Install the application as System Administrator 
and provide full read/write access rights to the 
folder and sub-folders where the application has 
been installed, for all applicable users 

• Internet Explorer 6.0 or above required 

• For Vitalograph COMPACT Reports - Microsoft's 
Windows Mobile Device Center (Windows Vista 
Users) or Windows Active Sync® 4.5 or above 
(Windows XP and earlier) is required to be 
installed and connected to the Vitalograph 
COMPACT Device.  These may be found at:  
http://www.microsoft.com/windowsmobile/activesync/default.mspx 
Microsoft's Windows Mobile Device Center may 
already be installed on some Windows Vista 
systems as standard.  

• Microsoft Service Pack 2 for Windows XP is 
required when using Vitalograph Model 4000 
Bluetooth devices. Service Pack 2 installation 
may be found at: 
http://www.microsoft.com/downloads/details.aspx?FamilyId=049C9
DBE-3B8E-4F30-8245-9E368D3CDB5A&displaylang=en 

 

 

INSTALLING VITALOGRAPH REPORTS 

Access level requirement for installation 

The Vitalograph Reports Setup installer requires that the user 
performing the installation to have complete and unrestricted access to 
the computer during installation. 
 

Commencing the Install 

There are two ways to start the installation process for Vitalograph 
Reports. 

1. Insert the CD into the CD drive and the installation wizard will 
start automatically. 

2. Alternatively, insert the CD and then in Windows Explorer 
browse to the drive letter corresponding to your CD drive.  
Double click on the “Setup.hta” file.  Click on the “Software 
Install” menu item on the left hand tool bar.  Click on the 
Vitalograph Reports button/link.   
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Using with the ALPHA Device: 
When Vitalograph Reports has been installed; follow the 
instructions listed in the “InstallingUSBDriverForALPHA” 
manual. 

 
Using with the Model 4000 Device: 
When Vitalograph Reports has been installed; follow the 
instructions listed in the “InstallingUSBDriverForModel4000” 
manual. 
 
Using with the Model 4000 Bluetooth Device: 
When Vitalograph Reports has been installed; follow the 
instructions listed in the 
“InstallingBluetoothDriverForModel4000” manual. 

 
Using with the In2itive Device: 
When Vitalograph Reports has been installed; follow the 
instructions listed in the “InstallingUSBDriverForIn2itive” 
manual. 

 

Automatically installing the .NET 2.0 Framework 

If your machine does not have the .NET 2.0 Framework installed on it, 
the install wizard will automatically detect this and present the following 
.NET 2.0 Framework Setup screen. 
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You must choose “Accept” at this screen and install the .NET 2.0 
Framework.  Failure to do this will render the application and 
application install inoperable, as they all rely on the .NET Framework.  
If you are not presented with this screen, the install wizard has 
detected that your machine already has the .NET 2.0 Framework 
installed on it, therefore it will proceed directly to the Vitalograph 
Reports Setup automatically. 
 
Once “Accept” has been chosen, the .NET 2.0 Framework install 
commences.   
 



Vitalograph Reports User Manual 
Cat. No. 07339 

                                                                                          Issue 5 

Page 10 of 45                                                                                                                                 DT_0006-6 
 

 
 



Vitalograph Reports User Manual 
Cat. No. 07339 

                                                                                          Issue 5 

Page 11 of 45                                                                                                                                 DT_0006-6 
 

Installing the Vitalograph Reports Software 

Welcome Screen 

Once the .NET 2.0 Framework has been successfully detected or 
installed on the PC, the Vitalograph Reports Setup installer will be 
presented on the Welcome Screen as shown below.  Click “Next” to 
continue.  Clicking “Cancel” at this stage or at any stage during the rest 
of the installation process will Cancel the Vitalograph Reports 
installation but not remove the Microsoft .NET 2.0 Framework.  The 
.NET 2.0 Framework may be removed by going to Control Panel->Add 
or Remove Programs, then browsing to “Microsoft .NET Framework 
2.0” and choosing “Remove”. 
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License Agreement 

The License Agreement must be read in full and then the “I Agree” 
radio button chosen before the “Next” button becomes activated.  
Choose “Next” to continue. 
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Installation Folder 

Prior to copying the relevant files to the PC, the installation folder may 
be changed.  A default is chosen as “C:\Vitalograph\VitalPrint\”.  Also 
note that a default folder is created “C:\Vitalograph\VitalPrint\Reports”, 
for any PDF files generated by the application.  
 
Note: PDF save location and Printing options are disabled when the 
selected device is a Vitalograph Model 4000 as this device uses 
PDF995 software which prompts to save the report to the last known 
saved folder of the Windows Operating System. The user must also 
use a PDF Reader such as Adobe Reader (available on installation 
CD) to view and print these reports. 
 
To select a different install folder choose “Browse” and using the 
Windows Browse window, choose an alternative install directory.  Note 
the default directory for the reports will remain as 
“C:\Vitalograph\VitalPrint\Reports”.  This may be changed within the 
application after installation, through the “Options” menu. 
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Choosing the “Disk Cost” button will display the amount of space 
available on the various disk drives on the system, along with the 
amount of space required by the application. 
 

 
An option also exists to install the application for just you (restricted by 
windows login) or for anyone who uses the computer. 
 
Choose “Next” to continue. 
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Confirm Installation 

At this stage, the installation wizard is ready to copy all the required 
files to the system.  Choose next to confirm the installation. 
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Installing 

During the actual installation of the application and associated files, the 
following progress screen will be presented. 
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Installation Complete Confirmation 

Once the application has successfully installed, the user shall be 
presented with the following confirmation screen.  Choose “Close” to 
complete the installation process. 
 

 
 

IMPORTANT NOTE for Vitalograph COMPACT Users 

To use Vitalograph Reports with the Vitalograph COMPACT device, 
you must first download, install and connect Microsoft's Windows 
Mobile Device Center (Windows Vista Users) or Windows Active 
Sync® 4.5 or above (Windows XP and earlier) to the Vitalograph 
COMPACT Device.  These may be found at: 
http://www.microsoft.com/windowsmobile/activesync/default.mspx   
Microsoft's Windows Mobile Device Center may already be installed on 
some Windows Vista systems as standard. 
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IMPORTANT NOTE for Vitalograph Model 4000 Users 

To view and print reports produced with the Vitalograph Model 4000 
device, you must first install Adobe Reader. This software can be 
installed from the CD or the latest version can be downloaded from: 
http://www.adobe.com. 
 
Instructions on installing Vitalograph Model 4000 device drivers can be 
found in the documents folder of the CD. The name of the document is 
InstallingUSBDriverForModel4000. 
 

STARTING VITALOGRAPH REPORTS 

Short-Cuts 

The installation process creates a number of short-cuts/options for 
starting Vitalograph Reports. 

1. Choose Start->All Programs->Vitalograph Reports-
>Vitalograph Reports 

2. On the Windows Desktop, double click on the “Vitalograph 
Reports” Icon/Short-cut 

 
Note: 
Once the application has successfully started, a Vitalograph icon will 
be shown in the services section of the Windows Task Bar, as 
highlighted in red below.  This is the only initial indication that the 
application has started.  The application will not be shown on the main 
screen by default.  
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First Start-up 

When Vitalograph Reports has been started for the first time, an initial 
configuration form will be displayed. This configuration form allows the 
user to choose the device they are attempting to synchronise with. If 
the device selected uses serial communication, the communications 
port drop down list will also be visible to allow the user to choose the 
communications port the device will be communicating through. 
 

 
 

Application Modes 

Once the application has successfully started, a Vitalograph icon will 
be shown in the services section of the Windows Task Bar.  Right click 
on the icon with the mouse to display a list of application options. 
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Showing the Application On-Screen 

To show the application on-screen, and display it in the main windows 
task bar, click on the “Show Application” menu item. 
 

Hiding the Application 

To hide the Application again, i.e. remove it from view from the screen 
and the main windows task bar, click on “Hide Application”. 
 

Starting the Report Service 

“Start Report Service” will start the application listening for print 
messages from the connected/selected device.  Once the application 
has started, it will listen for incoming report messages from the 
connected device.  Once the application receives a complete report 
from the connected device, it will either print the report, save it as a 
PDF file or do both depending on what has been set-up in the Options 
menu.   
 
Note: The default setup is for the application to connect to the 
Vitalograph micro device on Port 1.  Once a complete report has been 
received the default is to create a PDF file in the 
“C:\Vitalograph\VitalPrint\Reports” folder.  To change any of the default 
options for the application, refer to the VITALOGRAPH REPORTS 
OPTIONS Section. 
 

Stopping the Report Service 

“Stop Report Service” will stop the application listening for print 
messages from the connected/selected device.  Once stopped the 
“Tools” menu option will be re-enabled on the main application window.  
Stopping the report service does not shut down the application 
completely. 
 

Shutting Down the Application 

“Shut Down Application” will shut down the application completely.  To 
reuse the application, it will have to be restarted. 
 
Note: 
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These options may also be accessed from the main menu bar in the 
application under the “File” menu item, once the application has been 
shown on-screen. 
 

Status Bar and Status Indicators 

A status bar is displayed at the bottom of the application.  This displays 
what Vitalograph Device the application is connected to and what its 
current communication status with the device is. 
 
The application status indicator may display any of the following status 
in the bottom left hand side of the status bar: 

• Not Running – The application is not listening for any report 
messages 

• Connecting – Attempting to connect to the selected Vitalograph 
device on the port number selected 

• Connected – The application is actively listening for report 
messages from the connected device on the chosen port 

• Connection Failed – The application failed to connect to the 
selected device on the port number specified 

• Receiving Data – The application is receiving data from the 
connected device 

• Printing… - The application is sending the received data/report 
to the selected printer 

• Writing the PDF – The application is creating a PDF report from 
the data received and placing it in the chosen reports directory 

• Print Complete – A print job/PDF creation has been completed 
by the application 

• Connection Lost – A print job has failed due to a 
communications error. 

 

VITALOGRAPH REPORTS OPTIONS 

When the application is listening for incoming print messages from the 
connected device, the “Tools” menu item is disabled.  To re-enable the 
“Tools” menu item, stop the print service by clicking on the “Stop” 
button in the Toolbar, or by selecting the “Stop Report Service” menu 
item. 
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Application Defaults 

When the application has been started for the very first time, it will be 
started with the following default options: 

• Connect to Vitalograph Micro Device on Port 1 

• Save as PDF - Automatically save any completed report jobs 
as a PDF in the “C:\Vitalograph\VitalPrint\Reports” directory. 
This does not apply to Vitalograph Model 4000 reports. The 
save location for Vitalograph Model 4000 reports is chosen 
after generating the PDF file. 

• Use the date and time of when the report was created as the 
PDF filename 

 

Buttons and Icons Used 

 
 
Start Connect to the selected Vitalograph device and start 

listening for incoming report messages from the device. 
Printer 
Setup 

Select the printer to which any printed reports will be sent.  

PDF 
Setup 

Select the PDF report file location and choose whether 
the file name is generated automatically by date and time 
or whether a file name must be entered each time a new 
report is received from the connected device. 

Comms 
Setup 

Select the attached Vitalograph device and Port Number 
to which the device is connected. 

Help Shortcut to the application Help system. 
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Changing the Connected Device and Port Number 

To change the connected device and the communications port to 
which the device is connected, click on the “Comms Setup” button on 
the application Toolbar.  Alternatively navigate the main menu bar.  Go 
to “Tools”, “Options” and then click on the “Printer and Device Setup” 
tab. The following screen will be presented. 
 

 
 
Select your connected Vitalograph Device from those available under 
the “Choose a Vitalograph Device” pull-down menu.  To change the 
port to which your device is connected, select from the available ports 
under the “Communication Port” pull-down menu.  Click the “Save” 
button to save your selected options. 
 
1. When selecting a Vitalograph ALPHA, COMPACT or In2itive from 

the device drop down list, the options form does not present a 
communications port drop down list. The user only needs to select 
the device and click the “Save” button, which will close the options 
form and save the selected device. 
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2. When selecting a Vitalograph Model 4000 device (copd-6, asma-1 

& Lung Monitor) from the devices drop-down list, the options form 
presents a check box labelled “Auto-Detect” and a button labelled 
“Test” instead of the communications port drop down list. For 
instructions on connecting to a Vitalograph Model 4000 device, 
refer to “Using with a Vitalograph Model 4000” section. 
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3. When selecting a Vitalograph Model 4000 Bluetooth device (copd-

6 Bluetooth, asma-1 Bluetooth & Lung Monitor Bluetooth) from the 
devices drop down list, the options form presents a button 
“Discover Bluetooth Devices” and a check box “Show Previous 
Devices” instead of the communications port drop down list. For 
instructions on connecting to a Vitalograph Model 4000 Bluetooth 
device, refer to “Using with a Vitalograph Model 4000” section. 
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Printing Options 

1. To send any received reports to the Printer, first go to the “Tools” 
menu option and click on “Send to Printer”.  A tick mark will 
appear beside this option, when it has been selected. 

2. Then select the printer to which you wish the report to be printed.  
Either click on the menu items, “Tools”, “Options…” and select 
the “Printer and Device Setup” tab or select the “Printer Setup” 
option from the main application Toolbar.  Choose your printer 
from those installed on your system using the pull-down menu 
provided.  

3. Choose the “Save” button to save your selected options. 

 

Note: When the chosen Vitalograph device is a Vitalograph Model 
4000, this option is disabled. All Vitalograph Model 4000 reports are 
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generated in PDF format. To view and print reports produced with 
Vitalograph Model 4000 devices, you must first install Adobe Reader. 
This software can be installed from the CD or the latest version can be 
downloaded from: http://www.adobe.com. 
 

Save as PDF Options 

1. To save any received reports as a PDF, first go to the “Tools” 
menu option and click on “Save as PDF”.  A tick mark will appear 
beside this option, when it has been selected. 

2. Go to the PDF Setup options screen.  Either click on the menu 
items, “Tools”, “Options…” and select the “PDF Setup” tab or 
select the “PDF Setup” option from the main application Toolbar. 

 

 

 

3. The “Browse” button may be chosen to change the location 
where the PDF reports are placed.  The Windows Browse 
window will be displayed allowing an existing folder to be chosen 
or a new folder to be created.  Choosing OK in this window will 
populate the “PDF File Location” in the PDF Setup Options with 
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the chosen folder. This does not apply to Vitalograph Model 4000 
device reports as the report save location can only be chosen 
after the report has been generated. When the chosen 
Vitalograph device is the Vitalograph Model 4000, this option is 
no longer enabled.   

There are two options for PDF file name generation.  One is to 
generate the file name automatically using the current print date 
and time.  Alternatively, there is the option to manually enter a 
file name after the full report has been received from the device.  
To select either of the options, click on the radio button beside 
the required choice. 

 
If the “Manually Enter File Name after Printing” option is chosen, 
a pop-up window will be displayed every time a report is ready to 
be written to the chosen report location.  When this window is 
displayed, enter in the name of the file name to be saved and 
choose “Save”.  The PDF report will be saved with that name to 
the chosen PDF file location. 

 

 

 
Note: This option is not available when the attached device is a 
Vitalograph Model 4000. The user will be prompted to name a report 
from this device when choosing the save location. 
 

Time Zone Options 

The time zone option is available for all Vitalograph Model 4000 
reports. To enable this option the selected device must be a model 
4000. Go to “Tools”, “Options” and then click on the “PDF Setup” tab. 
By default “Use UTC time zone” is selected. This option does not 
manipulate dates of sessions. If “Use PC time zone” option is selected, 
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the date and time of all sessions are updated to match the time zone 
currently selected by the operating system before the report is 
generated. This option also accounts for daylight savings time. “Select 
time zone” enables the drop down list allowing the user to manually 
select the country and its time zone they would like the reports to be 
generated in. 
 

 
 

Custom Report Header 

Vitalograph Model 4000 reports contain customisable headers. To 
enable this option, the selected device must be a Vitalograph Model 
4000. The custom header can be edited by going to “Tools”, “Options” 
and then click on the “Custom Report Header” tab. It is also possible to 
edit the custom header from the additional information form prior to 
generating a PDF report. 
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Preferences 

Additional options for Vitalograph Reports can be changed, by going to 
“Tools”, “Options” and then click on the “Preferences” tab. From here 
you can choose to minimise the application automatically to the system 
tray when it is started. 
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If the selected device is a serial or USB Vitalograph Model 4000, 
additional preferences will be visible to launch Vitalograph Reports 
once the PC has been powered on and to clear the memory of the 
connected Vitalograph Model 4000 device after it has printed a report. 
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USING WITH A VITALOGRAPH 2120/GOLD STANDARD PLUS 

1. When using Vitalograph Reports with a Vitalograph 2120 or Gold 
Standard Plus device, you must ensure that the device is in the 
main menu before the application connects to the device, 
otherwise the application will be unable to connect to the device.   

2. The printer on the device must be set to a Hewlett Packard printer 
before connecting to the device via Vitalograph Reports.  To do 
this, choose the following on the device: SETUP->PRINTER-
>HEWLETT PACKARD. When asked whether to “Print via a Base 
Station?” choose No. 

 

USING WITH A VITALOGRAPH MODEL 4000 

There are three variants of the Vitalograph Model 4000 device. The 
Serial, USB and Bluetooth Vitalograph Model 4000 devices all 
communicate with Vitalograph Reports. 
 

Connecting to a Serial / USB Vitalograph Model 4000 

In the options menu under “Printer and Device Setup”, one of the 
Vitalograph Model 4000 devices from the device drop down list must 
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be selected. The device must be connected and powered on. The 
Vitalograph Model 4000 Series include the copd-6, asma-1 and Lung 
Monitor. The port on which the device is communicating must also be 
selected. If the user is unsure of the port number, clicking the test 
button while the device is connected and powered on will locate and 
return a message alerting the user of the correct port number. The 
user can also check the auto-detect check box instead of selecting the 
correct port number. This will allow Vitalograph Reports to search all 
ports to locate the device. Click the “Save” button, which will close the 
options form and then click the “Start” button on the main form to start 
Vitalograph Reports. 
 

 

 

Connecting to a Vitalograph Model 4000 Bluetooth Device 

In the options menu under the “Printer and Device Setup” tab, one of 
the Vitalograph Model 4000 Bluetooth devices from the device drop 
down list must be selected. The Vitalograph Model 4000 Bluetooth 
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Series include the copd-6 Bluetooth, asma-1 Bluetooth and Lung 
Monitor Bluetooth. Once one of these Bluetooth devices has been 
selected, the options form presents a button “Discover Bluetooth 
Devices” and a check box “Show Previous Devices” instead of the 
communications port drop down list. The Vitalograph Model 4000 
Bluetooth device must be powered on before the search for Bluetooth 
devices begins. Clicking the “Discover Bluetooth Devices” button 
opens the Bluetooth Device Discovery form and automatically begins 
searching for Vitalograph Model 4000 Bluetooth devices. When the 
Bluetooth Device Discovery form has completed its search for 
Bluetooth devices, the status changes from “Searching” to “Device 
names acquired” and populates the Discovered Devices list with 
Vitalograph Model 4000 Bluetooth devices located in the area that 
have been powered on. Checking the “Show Previous Devices” check 
box before opening the Bluetooth device discovery form will show 
previously found devices and will not begin searching for new 
Bluetooth devices automatically.  To connect to a Vitalograph Model 
4000 Bluetooth device the user must select a device from the 
discovered devices list and click the connect button. If the connection 
is successful the form will close automatically and the user will return 
to the options form. Click the “Save” button, which will close the 
options form and save the selected device. Click the “Start” button on 
the main form to start Vitalograph Reports. 
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Printing From a Vitalograph Model 4000 Device 

Vitalograph copd-6: To print a report from the copd-6 device the user 
must reach the print screen on the device. The print screen, which 
contains a print icon, appears in two places on the device. One is at 
the end of completing a new session. The user must scroll through the 
test screens until the print icon is reached. At the print icon screen the 
user must click enter to print. The other option is to print the last saved 
session by holding the enter button for three seconds on the first 
screen of the device, scrolling to the print icon once the previous 
session is displayed and clicking enter. 
 
Vitalograph asma-1 & Vitalograph Lung Monitor: To print a report 
from the asma-1 or Lung Monitor device the user must click and hold 
the "up" button on the first screen of the device until the report icon 
appears. The print icon also appears after a test has been performed 
on the device by scrolling through the test screens to the print icon. On 
this screen the user can print the current test by clicking enter. 
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Vitalograph Reports will then check the time of the device and update 
to UTC (Universal Coordinated Time) if the device time is incorrect. 
The sessions if any will be read from the device and will automatically 
update the time of each incorrect session. 
 
1.   PDF save location and Printing options are disabled while using 
the Vitalograph Model 4000 as this device uses PDF995 software 
which prompts to save the report to the last known saved folder of the 
Windows Operating System. The user must also use a PDF Reader 
such as Adobe Reader (available on installation CD) to view and print 
these reports. 
 
2.   When a report has been received from one of the Vitalograph 
Model 4000 devices, a new form appears. This form allows the user to 
enter additional information before generating the PDF report. None of 
the fields are mandatory. Checking the "save information" checkbox 
saves the additional information to a configuration file to be used 
repeatedly. Clicking "continue" will close the form and generate the 
report, once the user has selected a save location. 
 

Note for copd-6 report: The additional information form for the copd-6 
report contains options to disable the subjects name and interpretation, 
which will exclude the information when generating the report. 
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USING WITH A VITALOGRAPH IN2ITIVE 

The Vitalograph In2itive device can be connected through the USB 
port at the side of the unit or from the cradle to the Vitalograph Reports 
Utility, so that the report can be written to a PC. Once the In2itive 
device is connected and powered on the user can select the In2itive 
device from the device list in the options form and then connect to the 
device by clicking start on the main form. 
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Printing From an In2itive Device 

You can print the current test session for the subject by selecting ‘Print’ 
from the FVC Test screen. You can also select the Report option from 
the Main Menu. If you already have a Current Subject selected the 
following options are available: 
1. Current Test Session: You can select to print the current test 

session. 
2. Select Test Session: You can select a test session for the current 

subject. 
3. All Test Sessions: You can print all test sessions for the current 

subject. 
 
You can also print Test Session(s) from a different subject in the 
database. Selecting the ‘Select’ tab in the View and Report screen 
does this. The following options are available: 
1. Select Test Session: You must first select a subject from the 

database, and then select a test session for that subject to print. 
2. All Test Sessions: This will print all test sessions performed on a 

subject. When you select this option you must first select a subject 
from the database. 
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3. All Test Sessions Between: This will print all sessions stored on the 
device between specified dates. You must first select the dates. 

 

TROUBLE-SHOOTING SOFTWARE RELATED PROBLEMS 

Problem: 
Cannot connect to the attached device 
 

Remedy: 
1. If you have a Vitalograph ALPHA device 

a. Make sure the ALPHA driver has been installed.  To do this, 
follow the instructions listed in 
“InstallingUSBDriverForALPHA.pdf” located in the 
“Documents” folder on the CD. 

b. If the driver was already installed, while the ALPHA is turned 
on, pull out the USB connector from the device and reconnect 
it with the device switched on. 

2. If you have a Vitalograph COMPACT device: 
a. Try disconnecting the USB cable from the PC and 

reconnecting it while the COMPACT device is turned on. 
b. Please make sure you have installed and connected 

Microsoft's Windows Mobile Device Center (Windows Vista 
Users) or Windows Active Sync® 4.5 or above (Windows XP 
and earlier) to the Vitalograph COMPACT Device.  These may 
be found at: 
http://www.microsoft.com/windowsmobile/activesync/default.mspx 

3. Microsoft's Windows Mobile Device Center may already be 
installed on some Windows Vista systems as standard. 

4. If your device is not a Vitalograph ALPHA or Vitalograph 
COMPACT device, firstly make sure you know which port the 
device is connected to.  To see a list of available Ports, go to the 
Windows Control Panel->System->Hardware Tab->Device 
Manager Button.  Expand the Ports node to see what 
Communications Ports are on your PC.  If a USB to Serial 
converter is in use, it should be listed here also as an available 
port.  The word COMx will be displayed for all available 
Communications Ports where x represents the actual port number.  
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a. Make sure there is not another device attached to the PC, 
which is also competing for the same Port. 

b. Make sure the attached device and port number correspond 
with what has been saved in the options windows of 
Vitalograph Reports.  In the Vitalograph Reports application go 
to Tools->Options->Printer and Device Setup Tab and make 
sure the correct Vitalograph Device and Communications Port 
have been chosen.  Note: There is no need to pick a port for 
the ALPHA device as it is a USB device and the port will be 
automatically detected. 

c. Make sure that the device is connected to a free serial 
communications port on the PC. 

5. When using Vitalograph Reports with a Vitalograph 2120 or Gold 
Standard Plus device, you must ensure that the device is in the 
main menu before the application connects to the device. 

6. When using Vitalograph Reports with a Vitalograph model 4000 
device, you must ensure that the device is connected to the PC 
before starting the print utility. After the start print utility button has 
been clicked on Vitalograph Reports, the device must then be 
powered on while the print utility is searching for the device.   

 
Problem: 
The report was sent from the attached device but was not printed or 
saved by Vitalograph Reports. 
 
Remedy:  
1. Go to the main application window.  Click on “Tools” and make 

sure there is a tick mark next to the required report output type i.e. 
“Send to Printer” and/or “Save to PDF”. 

2. If you have a Vitalograph COMPACT device: 
a. Try disconnecting the USB cable from the PC and 

reconnecting it while the COMPACT device is turned on. 
b. Please make sure you have installed and connected 

Microsoft's Windows Mobile Device Center (Windows Vista 
Users) or Windows Active Sync® 4.5 or above (Windows XP 
and earlier) to the Vitalograph COMPACT Device.  These may 
be found at: 
http://www.microsoft.com/windowsmobile/activesync/default.mspx 
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3. Make sure the attached device and port number, if applicable, 
correspond with what has been saved in the options windows of 
Vitalograph Reports.  Also, for non-USB devices, go to Tools-
>Options and make sure the correct Vitalograph Device and 
Communications Port are chosen.  

 
 
Problem: 
The report received from the attached Vitalograph 2120 or Gold 
Standard Plus device was incomplete or corrupted. 
 
Remedy: 
Make sure that Hewlett Packard is the chosen printer on the hardware 
device.  To select Hewlett Packard as the chosen printer, from the 
main menu on the hardware device, choose the following: SETUP-
>PRINTER->HEWLETT PACKARD.  When asked whether to “Print via 
a Base Station?” choose No. 
 
Problem: 
The Vitalograph Reports print service was stopped during a print-job 
but the attached Vitalograph 2120 or Gold Standard Plus device still 
displays the “Printing” message. 
 
Remedy: 
Click on the “ESC” key on the attached device.  The device will return 
to the main screen within a number of seconds. 
 
Problem: 
The status bar on the application shows “Receiving Data” infinitely 
without ever printing or saving the PDF report. 
 
Remedy: 
Ensure that the user on the PC has full read/write access rights to the 
folder & sub-folders of both the location where the Vitalograph Reports 
application was installed and also the location chosen to save the PDF 
report files.  The System Administrator on the PC will have to set these 
security settings. 
 
Problem: 
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The status bar on the application shows that the PDF report was 
created but it does not appear to have been created/saved to the PC. 
 
Remedy: 
Ensure that the user on the PC has full read/write access rights to the 
folder & sub-folders of both the location where the Vitalograph Reports 
application was installed and also the location chosen to save the PDF 
report files.  The System Administrator on the PC will have to set these 
security settings. 
 
Problem: 
An error message appears saying that an instance of the application is 
already running even though no Vitalograph icon is visible in the 
processes section of the task-bar. 
  
Remedy: 
Hold down the Keys Ctrl, Alt, then Delete all together.  Press the “Task 
Manager” button.  Click on the Processes tab and look for a process 
called “VitalographReports.exe”.  This is the Vitalograph Reports 
application.  To end the process, click on it to highlight it and then click 
the “End Process” button.  Once closed, a new copy of the application 
may be started. 
 
Alternatively, it may be that another user is also logged onto the 
system using the “Switch User” Windows function and that user may 
have an instance of the application running.  Make sure there are no 
other users logged onto that system with the application running. 
 
Problem: 
During the Setup, if the installation path chosen is above 175 
characters, the Application will not install successfully. 
 
Remedy: 
Ensure your installation folder path name is less than or equal to 175 
characters in length. 
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CUSTOMER SERVICE 

The manufacturer or service personnel specifically trained and 
approved by Vitalograph Ltd. or its associated companies should only 
carry out SERVICE and REPAIRS. 

GUARANTEE 

Subject to the conditions listed below, Vitalograph Ltd. and its 
associated companies, (hereinafter called the Company) guarantee to 
repair or at its option replace any component thereof, which, in the 
opinion of the Company is faulty or below standard as a result of 
inferior workmanship or materials. 
 
The conditions of this Guarantee are: 
1. This Guarantee shall only apply to hardware defects, which are 

notified to the Company or to its accredited distributor within 1 year 
of the date of purchase of the equipment, unless otherwise agreed 
in writing by the company. 

2. Software (meaning computer software, or user installable modules) 
is guaranteed for 90 days from the date of purchase. 

3. The company warrants that the software when correctly used in 
conjunction with the hardware will perform in the manner described 
in the Company's literature and user manuals. The company 
undertakes to rectify at no expense to the customer any software 
failure notified within the period stated above, provided that the 
failure can be recreated and the software has been installed and 
used in accordance with the user manual. Notwithstanding this 
clause, the software is not warranted to be free of errors. 

4. This Guarantee does not cover any faults caused by accident, 
misuse, neglect, tampering with the equipment, use of consumable 
items or parts not approved by the Company, or any attempt at 
adjustment or repair other than by personnel accredited by the 
Company, nor does it cover reinstatement of any configuration 
changes caused by the installation of any software. 

5. If a defect occurs please contact the supplier from whom it was 
purchased for advice. The Company does not authorise any person 
to create for it any other obligation or liability in connection with 
Vitalograph® equipment. 

6. This Guarantee is not transferable and no person, firm or company 
has any authority to vary the terms or conditions of this Guarantee. 
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7. To the maximum extent permitted by law, the Company does not 
accept liability for any consequential damages arising out of the use 
of, or inability to use any Vitalograph® equipment. 

8. This Guarantee is offered as an additional benefit to the 
Consumer's statutory rights and does not affect these rights in any 
way. 


